


FLUX
3D Volumetric Fractal Flames  
for After Effects and Premiere Pro.
 

Features
Supported Formats: Flat (Rectilinear), 360° Monoscopic, Stereoscopic O/U and SBS.

FLUX Preset Panel for one click application of animations 

Additional presets in FLUX Effects Control Panel

Mettle Globe Preview Panel lets you work and view results in 360°

Fully customize with: Force Field, Mutations, Iterations, Evolutions, Lights, and 
Symmetry

GPU Accelerated, with Volumetric Rendering

Supports native After Effects 3D camera

Built-in camera for After Effects and Premiere Pro 

www.mettle.com
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METTLE FLUX
Supported hosts:  * After Effects and Premiere Pro CC  and Later.
One purchase of FLUX allows 2 activations. 
FLUX effects can be applied directly on equirectangular footage, flat footage, or on 
a Solid on a Layer. We support Mono, Stereo Over Under, Stereo Side-By-Side and 
Rectilinear (traditional Flat video).

Installation
Use the Mettle Product installer to install FLUX plugin. Please make sure that you 
have not renamed or moved your Adobe product folders from their default install 
locations. This will cause installer errors.

How To Register 
In After Effects, apply the  FLUX effect to your Solid or footage on your comp layer. 
In the FLUX Effect Controls panel, click on “Register”.

In the Register Window, enter your Mettle account email address and password. 

Click on “Refresh” and “Activate”  to remove watermark from purchased plugin. 
How To Deactivate Your license Key On One Computer And Activate  
On Another
Simply click on “Deactivate All” in the Register Window on one computer, then 
enter your info on the other computer in the Register Window and then click on 
Activate.
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Mettle Globe Preview
Mettle includes a Globe Preview Panel (in After Effects only), which dis-
plays your 360° comp in close to real time on a Sphere and HMD preview.
You can rotate globe with mouse acceleration - it will make it continuously rotate, 
useful to observe effects as they are applied to your comp.

After Effects: Enable Globe Preview. Preferences > Video Preview >  
Enable Mercury Transmit + Mettle Globe Preview.

Enable Globe Preview: Premiere Pro. Preferences - Enable Mercury 
Transmit + Mettle Globe Preview.
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Mettle Globe Preview cont’
Window > Extensions > Mettle Globe Preview

Mettle Globe Preview Panel Appears (with default image). Click on 
timeline to refresh view.
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Rotate the Sphere by clicking and 
dragging with your mouse to see 
every view. 

Panel is Dockable. Effects are displayed on the Globe Preview.
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Mettle Globe Preview cont’



Mettle Globe Preview cont’

Click on wireframe Globe icon to apply 
wireframe guide.

Select Layout: Click on > Monoscopic > 
Sterescopic Over Under > Stereoscopic 
Side by Side.  
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Navigate on the Sphere by clicking on 
the different regions of the Cubic Cross. 

Double click on Globe to enter Sphere. 
Clicking on squares in the Cubic Cross, 
or swipe with your mouse to navigate 
through all views.
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FLUX PARAMETERS: FRAME LAYOUT
FLUX supports traditional flat video (Rectilinear), 360° Monoscopic and Stereoscopic 
Over Under and Stereoscopic Side By Side. 

Select a format from the drop-down menu.

Monoscopic

Monoscopic (360°) Frame layout, Phoenix Preset

Monoscopic (360°) Frame layout, Phoenix Preset
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Stereoscopic - Side By Side (360°) Frame layout, Phoenix Preset

Stereoscopic - Over/Under (360°) Frame layout, Phoenix Preset



FLUX Preset Panel
FLUX includes a Preset Panel, with  animations ready to go at the click of 
a mouse.

After Effects: Open FLUX Preset Panel. Window > Extensions >  
Mettle Flux Presets
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FLUX Preset Panel has 23 FLUX animation Presets .



FLUX Preset Panel - Cont’

FLUX Preset Panel is dockable. 

“Layer Not Selected” indicates that a solid has not been selected
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FLUX:  Getting Started 
After Effects - Create a Comp. If you are working in 360°, your comp needs to be a 2:1 
ratio, minimum (3840 x 1920) or (4096x2048) for 4K resolution.  
FLUX works with different sized comps, such as HD (1920 x 1080).

Create a Solid the same size as your comp. It can be the same length as your time-
line, or shorter. It should be the length of your desired FLUX animation.
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FLUX:  Effect Controls Panel> Presets
Select your Solid, and then  select  Effect > Mettle > Mettle FLUX

By default, there is no Effect applied, so your comp appears black. 

*NOTE: Flux Presets in the Effect Controls Panel are different than 
those found in the FLUX Preset Panel. 
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FLUX:  Effect Controls Panel> Presets
A great way to start your FLUX Volume is to Select a Preset.   
FLUX Effect Controls Panel > Presets > Solar Wind

There are a variety of presets  that can be used as starting points  
 Example: Preset > Supernova



FLUX:  Effect Controls Panel> Presets
Explore the Presets as a first step in further customisation. Apply more FLUX parameters, 
mentioned further in this Manual, to get the look you want.
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Create a comp that is the length of your desired animation. 

Create a Solid the same size and length as your comp. 

FLUX  Preset Panel > Applying the presets
The FLUX Preset Panel is a separate set of animated effects that can be 
applied with the click of a mouse. (See how to access Panel on P. 11)
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Select your Solid and click on one of the Preset images in the FLUX 
Preset Panel.

The FLUX Volumetric animation is automatically generated for the 
length  of the Solid on the timeline.

FLUX  Preset Panel > Applying the presets
FLUX includes a separate Preset Panel (See how to access Panel on Page. 11). 
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FLUX  Preset Panel > Applying the presets

To apply another FLUX Preset, Select your solid and click on 
another Image in the Panel.

The FLUX Volumetric animation is automatically generated as a 
second effect that can be adjusted with blending mode.
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FLUX PARAMETERS: Evolution X, Y, Z
Smoothly evolve current FLUX combination in three different ways. 
This is an easy way to keep the look and Volume of your fractal, and 
animate it. Select “Evolution X, Y, Z”, and keyframe with varying rota-
tion values to get the desired speed and look of your animation.

“Evolution X” 180° setting, Rectilinear Xenomorph Preset:

“Evolution X” 62° setting, Rectilinear Xenomorph Preset:



FLUX PARAMETERS: Evolution X, Y, Z  Cont’

QUICK TIP: An easy way to create a seamless loop is to keyframe 0° at the beginning of your timeline, and 359° at the end of 
your timeline. Example with Xenomorph Monoscopic Preset.
Seamless loop: 0° at beginning of timeline

Seamless loop: 359° at end of timeline
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FLUX PARAMETERS: Scale
Adjusts the global scale of current FLUX Volume. 

Note: This parameter is not linear so different values might highlight differ-
ent combinations of FLUX Volumetric features.

Default Scale 50 for FLUX Preset “Solar Wind” Rectilinear in Effect Controls Panel:



FLUX PARAMETERS: Scale Cont’
Default Scale 20 for FLUX Preset “Solar Wind” Rectilinear:

Scale 80 for FLUX Preset “Solar Wind” Rectilinear:
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FLUX PARAMETERS: Scale Cont’

Notice the difference when Monoscopic is selected: Scale 80 for FLUX Preset “Solar Wind” :
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FLUX PARAMETERS: Intensity
Adjusts the color intensity of the FLUX Volumetric combination. 

Note: This parameter is not linear, different values might highlight differ-
ent combination features. If you want to linearly control brightness, use 
Brightness parameter inside Volumetric Rendering group.

For example: “0.0 Intensity” still may be visible.

Intensity 50; Default setting for Solar Winds Preset:
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FLUX PARAMETERS: Intensity  - Cont’
Intensity 0:

Intensity 100:
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FLUX PARAMETERS: Iterations
You can adjust the total number of iterations (replications)  for current combi-
nation. Usually more iterations add more detail and sharpness, but it also might 
make combination darker or even make it vanish (degenerate).
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Iterations 12; Default setting for Solar Winds Preset:



FLUX PARAMETERS: Iterations Cont’
Intensity 2:

Intensity 15:
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FLUX PARAMETERS: Mutations 1, 2, 3, 4, 5
Mutations are the the main FLUX workhorse. It’s where all the mathematical 
transformations of the FLUX 3D Volume takes place. There can be up to 5 Muta-
tions enabled (in any combination). Usually it’s necessary to have a combination 
of at least 2 Mutations to get interesting results. Tweaking the Mutation parame-
ters is the key to get unique shapes. 

Note: When you select one of the FLUX presets, the Mutation parameters are 
automatically modified to give that result.
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FLUX PARAMETERS: Mutations Cont’
Enable
Each Mutation has a checkbox to “Enable”.  When you have created a FLUX Volume 
with a combinations of Mutations, they interact with each other. By clicking the 
checkbox on and off, you can see the effect.

Mutation 1 > M1 “Enable” not selected

Mutation 1 > M1 “Enable” selected
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FLUX PARAMETERS: Mutations Cont’
Variation  
Select the type of Math Variation for your Mutation. Each variation has unique 
visual properties and may look different on its own than when combined with 
other Mutations. 

Mutation 1 > Variation > Spherical

Quick Tip: Due to the recursive non-linear nature of Flux, when you change the 
Mutation Variation setting, the results will vary quite a bit. 

If you want to see how each Mutation parameter affects the original shape, set the 
Iterations to 1 and then adjust the parameters. This will show what’s happening 
on the very first iteration. The more iterations, the more complex the FLUX Volume 
becomes.
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Mutation 1 > Variation > Linear

FLUX PARAMETERS: Mutations Cont’
Variation  
Examples of different variations applied to the same FLUX Volume:

Mutation 1 > Variation > Sinusoidal

Mutation 1 > Variation > Swirl Mutation 1 > Variation > Heart

Mutation 1 > Variation > Fisheye Mutation 1 > Variation > Fisheye Forward



Mutation 1 > Color > H (Hue) 180, (S) Saturation: 60%, (B) Brightness 60%

FLUX PARAMETERS: Mutations Cont’
Color 
Select the primary color for the mutation. It might be useful to control hue, satu-
ration, brightness independently and see how it affects the Mutation.

Mutation 1 > Color > Select H: 235, S: 60,  B: 60 Mutation 1 > Color > H: 235, S: 60,  B: 60
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Mutation 1 > Brightness 100

FLUX PARAMETERS: Mutations Cont’
Brightness
You can adjust the brightness of the Mutation.

Mutation 1 > Brightness 25 Mutation 1 > Brightness 150
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Mutation > Scale XYZ > 310. This is Default setting for Phoenix, Rectilinear (Flat)

FLUX PARAMETERS: Mutations Cont’
Scale XYZ,  and Scale X, Scale Y, Scale Z
Scale XYZ adjusts the global scale of the Mutation (on all axes).

Scale X, Y, Z adjusts the scale of the Mutation on each axis.

Mutation > Scale XYZ > -400 Mutation > Scale XYZ > 1000

Note: The slider range setting shows -300 to 300. But 
the values can be set from -1000 to 1000.
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Mutation > Scale X > 50. This is Default setting for Preset Solar Wind, Rectilinear (Flat)

FLUX PARAMETERS: Mutations Cont’
Scale X, Scale Y, Scale Z
Scale X, Y, Z adjusts the scale of the mutation on each axis independently. The 
example below shows the Scale X axis. Scale Y and Scale Z function the same way.

Mutation > Scale XYZ > 100 Mutation > Scale X > -50
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Mutation > Shear ZX 159.26   

FLUX PARAMETERS: Mutations Cont’
Shear XY, XZ, YX, YZ, ZX, ZY

Mutation Shear adjusts shearing transformation of the mutation on different axes. 
A Shear is similar to a Skew. Each Shear produces a different effect.

Mutation > Shear 0 Mutation > Shear XY 155.56

37



Mutation 2 > RM2 Rotation X 40°, Y 50°, Z 0°. (Applied to FLUX Preset SuperNova)

FLUX PARAMETERS: Mutations Cont’
Rotation
Lets you Rotate the FLUX Volume on the X, Y, Z axes by adjusting the Euler angles 
rotation of the current mutation.

Note: The Euler angles are three angles introduced by Leonhard Euler to describe the 
orientation of a rigid body with respect to a fixed coordinate system. They can also 
represent the orientation of a mobile frame of reference in physics or the orientation 
of a general basis in 3-dimensional linear algebra.

Mutation 2 > RM2 Rotation X 0°, Y 0°, Z 0°. Mutation 2 > RM2 Rotation X 40°, Y 50°, Z 70°. 
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Mutation 1 > M1 Translation  X: -77.25°, Y: 12.57°, Z: 5.00°. (Applied to FLUX Preset Inkblots)

FLUX PARAMETERS: Mutations Cont’
Translation X, Y, Z
This adjusts the translation of the current mutation on different axes.  
This will affect the overall look of the FLUX Volume, since the Mutations interact 
with each other so changing the position of one relative to the other one(s) gives 
a very different result. Generally speaking, a small change in values will produce 
significant change.

M1 Translation  X: -55.00°, Y: 40.00°, Z: 5.00° M1 Translation  X: -55.00°, Y: 40.00°, Z: -48.50°
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FLUX PARAMETERS: Volumetric Rendering 
After a Flux Volume (Mutation combination) is generated, it’s time to render it 
using a volumetric renderer. Here we adjust its parameters.

Density: 107.8 (Default setting for Preset Xenomorph) Density: 640

Brightness: 107.8 (Default setting for Preset Xenomorph) Brightness: 329.3

Brightness
This Adjusts the FLUX volume brightness.

Density: 
Adjust volume density, i.e. How easy it is for lights to travel through the  
volume.
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FLUX PARAMETERS: Volumetric Rendering Cont’ 

Threshold Feather: 10.00 Threshold Feather: 51.50

Threshold Feather
This smoothens the threshold region.

Volume Blur: 2 Volume Blur: 7

Volume Blur 
This blurs the  region.

Threshold: 5.00 (Default setting for Preset Xenomorph) Threshold: 52.69

Threshold
Luma threshold to cull volume below this value. It helps to control  and reduce  
large regions of solid dim colors produced by some mutation combinations.
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FLUX PARAMETERS: 3D Transform
3D Transform
Once you have created your FLUX Volume, these parameters let you control 
the 3D properties. This is great for adjusting the exact size and position, while 
maintaining the overall look.

Volume 10.00 (Default setting for Preset Aurora Borealis) Volume: 56.0

Volume Size (m)

Adjust global size of the volume in meters. It is especially valuable when work-
ing in stereo mode. This will make the volume appear at a desired scale when 
viewed in HMD.
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FLUX PARAMETERS: 3D Transform Cont’
Volume Scale X, Y, Z (%)
Adjust the scale per axis.

Volume Scale Y: 100 Volume Scale Y: 1000

Volume Scale Z: 300 Volume Scale Z: -200

Volume Scale X: 100 Volume Scale X: 50
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FLUX PARAMETERS: 3D Transform Cont’
Volume Rotation X, Y, Z
Lets you adjust the Euler angles for rotation of the volume.

Volume Rotation Y: 90 Volume Rotation Y: 180

Volume Rotation Z: 90 Volume Rotation Z: 180

Volume Rotation X: 90 Volume Rotation X: 180
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FLUX PARAMETERS: Volume Position
Volume Position X, Y, Z (m)
Adjust position of the volume in meters.

Volume Position Y: -5.0 Volume Position Y: 5.0

Volume Position Z: -5.0 Volume Position: 5.0

Volume Position X: -10.0 Volume Position X: 9.0
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FLUX PARAMETERS: Camera
Camera
Full set of 3D camera parameters. These parameters are overridden by AE camera 
if it’s detected. One of the reasons we included a camera is so you will have 
access to one in Premiere Pro.
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FLUX PARAMETERS: Camera Cont’
VFOV
Vertical Field Of View of the camera (in degrees). Horizontal FOV is set according 
to the frame aspect ratio.

VFOV: 60 (Default setting Solar Wind Preset)

VFOV: 20

VFOV: 100
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FLUX PARAMETERS: Camera Cont’
Stereo IPD (mm)
Interpupillary distance of the eyes. This affects stereoscopic projection disparity. 
The default setting is the right one for most Stereo productions. Change only if 
you know what you are doing.

Stereo IPD: Default setting is 64

Stereo Disparity Fade
Lets you adjust the amount of fade for objects that are too close to the camera 
(to avoid bad disparity). This  effect works in stereo mode only.
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FLUX PARAMETERS: Camera Cont’
Auto Orient to POI: Camera POI X, Y, Z (m)
Set camera Point Of Interest in meters (works only when Auto Orient to POI is 
enabled). 

Auto Orient to POI > Camera POI X:10

Auto Orient to POI > Y: 10

Auto Orient to POI > Z: 10

Click on Checkbox to enable auto 
orientation of the camera to 

Point Of Interest  
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FLUX PARAMETERS: Camera Cont’
Camera Rotation X, Y, Z
Lets you adjust Euler angles rotation of the camera.

Camera Rotation X > 90

Camera Rotation Y > 90

Camera Rotation Z > 90
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FLUX PARAMETERS: Camera Cont’
Camera Position X, Y, Z (m)
Lets you adjust the  camera position in meters.

Camera Position X > 6

Camera Position Y > 7

Camera Position Z > 0
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FLUX PARAMETERS: Symmetry
This feature lets you add symmetry to generated volume on all axes.

Symmetry Planes: 
None - no symmetry.

X - symmetrize only around vertical YZ plane (X=0).

XY - symmetrize around vertical YZ plane (X=0) and horizontal XZ plane (Y=0)

XYZ - symmetrize around all three orthogonal planes.

Symmetry Planes > None

Symmetry Planes > X
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FLUX PARAMETERS: Symmetry Cont’

Symmetry Planes > XY

Symmetry Planes  > XYZ
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FLUX PARAMETERS: Symmetry Cont’
Symmetry Offset X, Y, Z (%) 

Shift the center of symmetry on any axis. 

Note: This doesn’t shift the volume itself. It shifts the center of symmetry in the 
original volume, allowing us to symmetrize different regions.

Symmetry Planes > X; Offset X > 20; Offset Y > 0; Offset Z > 0

Symmetry Planes > XY; Offset X > 10; Offset Y > 10; Offset Z > 0
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FLUX PARAMETERS: Symmetry Cont’
Symmetry Rotation X, Y, Z

Adjust Euler angles to rotate symmetry plane.

Note: This doesn’t rotate the volume itself, it rotates the plane of symmetry 
allowing you to symmetrize different orientations of original volume.

Symmetry Planes > X Y Z ; Symmetry Rotation:  X > 90°; Y > 90°; Z > 90°

Symmetry Planes > X Y Z ; Symmetry Rotation:  X > 90°; Y > 90°;  Z > 0°
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FLUX PARAMETERS: Force Field
This feature simulates a displacement (force) field inside the FLUX volume.

FF Shape
Select the bounding shape of the force field: None, Sphere, Cube, Octahedron.

FF Shape > Sphere (Applied to Solar Winds Preset from Effect Controls Panel)
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FLUX PARAMETERS: Force Field Cont’

FF Shape Cont’

FF Shape > Cube

FF Shape > Octahedron
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FLUX PARAMETERS: Force Field Cont’
FF Shape Fill
Select whether the force field affects all of the volume inside the bounding 
shape or only its shell: Solid, Shell.

FF Shape Fill  > Shell
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FLUX PARAMETERS: Force Field Cont’
FF Shape Size (m)
Adjust force field size in meters.

FF Shape Size > 6

FFvShape Size > 2.0
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FLUX PARAMETERS: Force Field Cont’
FF Shape Feather
Adjust feather to smoothen bounding shape region.

FF Shape Feather > 0

FF Shape Feather > 80
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FLUX PARAMETERS: Force Field Cont’
FF Strength
Lets you adjust the strength of the force field.

FF Strength > 2

FF Strength > 10
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FLUX PARAMETERS: Force Field Cont’
FF Position X, Y, Z (m)
Lets you adjust the force field position in meters.

FF Position X  > 1

FF Position X  > 2

FF Position X  > 5
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FLUX PARAMETERS: Force Field Cont’
FF Position X, Y, Z (m) Cont’

FF Position Y > 2

FF Position Y >  -1
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FLUX PARAMETERS: Force Field Cont’
FF Position X, Y, Z (m) Cont’

FF Position Z  > -1

FF Position Z  > 0.1

FF Position Z  > 1

FF Position Z  > 2

Quick Tip:
Want your Force Field to really 
show as a defined moving shape? 
Animate along the Position Z val-
ue, relatively close to 0, to create 
a large disturbance going front to 
back, through the FLUX Volume, 
in Rectilinear (Flat) format.
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FLUX PARAMETERS: Force Field Cont’
FF Configuration Preset
Presets define various force field configurations that model different behavior: 
Explosion, Explosion Swirl, Implosion, Implosion Swirl, Swirl.

FF Configuration > Explosion

FF Configuration > Explosion Swirl

FF Configuration > Implosion
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FLUX PARAMETERS: Force Field Cont’
FF Configuration Preset Cont’

FF Configuration > Implosion Swirl

FF Configuration > Swirl
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FLUX PARAMETERS: Force Field Cont’
FF Azimuthal Configuration
Lets you adjust the force field configuration in the azimuthal plane.
Note: These values are automatically modified when you select a 
preset.

FF Az. Pathways Number
Adjust the number of pathways i.e. the number of distinctly visible streams.

FF Az. Pathways Orientation
Rotate pathways around its axis. 

FF Az. Spirality
Adjust pathways spirality.

FF Polar Configuration
Adjust force field configuration in the polar plane.

FF Configuration > Explosion

FF Configuration > Explosion Swirl
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FLUX PARAMETERS: Force Field Cont’
FF Azimuthal Configuration Cont’

FF Configuration > Implosion Swirl

FF Configuration > Swirl

FF Configuration > Implosion
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FLUX PARAMETERS: Lights
Lights
Add up to 5 point lights to highlight specific regions of the volume.

Light Enable
Switch the light on/off.

Light Position X, Y, Z (m)
Adjust light position in meters.

Light Radius (m)
Adjust light radius in meters.

Light Color
Select light color.

Light Intensity
Adjust light intensity.

Light Attenuation
Adjust light attenuation (falloff)

Light Vacuum Scattering
Can be enabled “On/Off” with a checkbox. 
Lets you add organic gradients to the volume when it is Enabled.
Choose whether the light should highlight empty regions inside the volume or 
only the shape itself. 

Lights Rotation X, Y, Z
Adjust Euler angles rotation of all light. This will rotate the whole light system.

Lights Translation X, Y, Z (m)
Adjust the position of all lights. This will translate the whole light system.
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FLUX PARAMETERS: Lights Cont’

Lights > Not Enabled

Lights > Enabled
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FLUX PARAMETERS: Lights Cont’

Lights Translation X > 1.8

Lights Translation X > 6
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FLUX PARAMETERS: Lights Cont’
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L1 Vacuum Scattering “Enabled”

L1 Vacuum Scattering “Not Enabled”



FLUX PARAMETERS: Opacity and Blending Mode

Opacity
Designate how opaque a given layer should be.

Blending Mode
Blending modes for layers control how each layer blends with or interacts with 
layers beneath it. Blending modes for layers in After Effects (formerly referred to 
as layer modes and sometimes called transfer modes) are identical to blending 
modes in Adobe Photoshop.
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